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abouT KnoLL LiGhT FaCToRy
Thank you for purchasing Knoll Light Factory. This package contains a range of 
easy-to-use plug-ins for creating realistic light effects and lens flares that you can 
use in many different types of projects. 

SuppoRTed appLiCaTionS & oS’S
Knoll Light Factory is a plug-in that runs inside a number of different host applica-
tions. Most of the features of Knoll Light Factory are identical across these various 
applications, though the interface may look different. These differences are cov-
ered in this manual’s application sections. 

We support three versions of Knoll Light Factory which work in the following ap-
plications and operating systems:

Version 2.5.5, Windows

•Adobe After Effects CS3, CS4 
•Premiere Pro 2.0, CS3, CS4 
•Avid Xpress Pro/Media Composer 5.6+, 2.6+ 
•Windows XP Pro, Windows XP Home, Vista 32-bit 
•Windows 7 32-bit, Windows 7 64-bit

Version 2.6, Mac

•Adobe After Effects CS3, CS4 
•Apple Final Cut Pro 5.1.4, 6.0, 7.0 
•Motion 3.02, 4.0 
•Avid Xpress Pro/Media Composer 5.6+, 2.6+ 
•OS 10.4.11, 10.5, 10.6

Version 2.7, Windows

•Adobe After Effects CS5 
•Premiere Pro CS5 
•Vista 64-bit, Windows 7 32-bit, Windows 7 64-bit

Version 2.7, Mac

•Adobe After Effects CS5 
•Apple Final Cut Pro 5.1.4, 6.0, 7.0 
•OS 10.5, 10.6
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SySTeM RequiReMenTS
Our tests have shown that our products perform best when used with the system 
configurations listed below. Although many of our products will run on older or 
less-powerful systems, those listed below are the minimum system requirements 
which we support.

apple Macintosh
Mac OS X 10.5.8 and later or 10.6 
Mac Intel system 
Minimum of 1 GB of RAM 
30 MB of hard drive space

pC / Windows
Windows XP 32-bit/64-bit 
Windows Vista 32-bit/64-bit 
Windows 7 32-bit/64-bit 
Minimum of 1 GB of RAM 
30 MB of hard drive space

Gpu Support 

Knoll Light Factory 2.5 requires a recent graphics card to get render acceleration. 
The plug-in will automatically test the card on startup. The GPU switch will auto-
matically be enabled or disabled if the graphics card can or cannot provide accel-
eration for Knoll Light Factory 2.5. 

Here are the cards that we recommend, along with expected acceleration for the 
flares. Each host application will provide different levels of performance and other 
factors such as flare preset, media size and hard disk or RAID speed will affect your 
actual playback and render speed. The best Open GL acceleration can be seen in 
applications like Apple Motion which feature native GPU support. 
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Mac oS X Speed expectations 

Speed Graphics Card

Good (4-8 fps playback) ATI 9600/9800 SE/Pro

Better (9-20 fps playback) ATI X800XT/X850 XT
NVIDIA 6600 GT/6800 GT DDL/6800 Ultra DDL

Best (16-30+ fps playback) NVIDIA 7800 GT/Quadro 4500

Mac OS X 10.4.3 or later is required and the GPU engine only renders 8-bit per channel. To 
achieve higher quality in After Effects with Knoll Light Factory Pro, you must switch the Do 
GPU switch to off.

Windows Xp Speed expectations

Speed Graphics Card

Good (6-11 fps playback) NVIDIA 6800/NVIDIA Quadro 1400
ATI X800/ATI X850 XT

Better (11-20 fps playback) NVIDIA 6800 Ultra/7600 GT
NVIDIA Quadro 3400/4000

Best (16-30+ fps playback) NVIDIA 7800/7900 GTX/NVIDIA Quadro 4500
ATI 1900 XT

 

Most video cards are supported but not all models have been tested and certified. 
Current drivers at the time of this publication are the NVIDIA 90 series or ATI Catalyst 
6.6. PLEASE USE THE LATEST DRIVER UPDATE ON WINDOWS TO ASSURE COMPATIBIL-
ITY AND PERFORMANCE. 

NOTE: On Windows XP, only NVIDIA-based graphics cards can deliver 16-bit per channel 
output in After Effects using the GPU. ATI drivers and graphics chips do not support the 
rendering mode required to output 16-bit/channel rendering. Rendering in 16-bit/chan-
nel on the CPU is supported on all graphics cards when the GPU switch is off.

To render on dual-screen systems, at least 256MB of video RAM is recommended and 
absolutely required if the output is HD resolution (720p or higher).  Lower resolution work 
with dual monitors can be accomplished by changing the maximum TextureResolution 
value to 1024 in the ‘settings.txt’ file that is installed in the same directory as the plug-in.
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pRoduCT inSTaLLaTion

installation

Knoll Light Factory comes packaged as a complete software installer. The in-
staller will automatically place the required components on your hard drive and 
guide you through the process of installing the software.

Please check www.redgiantsoftware.com for the latest compatibllity information.

activation

The final installation step before using Knoll Light Factory is entering your serial 
number into the registration dialog, which will appear the first time you run the 
installer. YOU MUST ENTER A SERIAL NUMBER TO USE KNOLL LIGHT FACTORY IN 
AUTHORIZED MODE. You will receive a confirmation email after your purchase 
that contains your serial number.

The serial number for Knoll Light Factory appears in the following format:

AAAA #### #### #### ####

The activation code is a series of 20 characters. You must enter all digits to 
complete the activation. You can also choose to run the software in demo mode 
simply by leaving the fields blank. If you choose, you can enter the serial number 
after installation by pressing the Options button in any of the host applications. 
The following dialog will appear so you can authorize your version.



Knoll Light Factory manual

8  ©2010 Red Giant Software

demo Mode

If you choose Demo on installation, the plug-in will 
run in demo mode until you enter a serial number. The 
output will contain a red “X” across the image in both 
previews and final renders. Click the Options button to 
open the Red Giant Software authorization screen and 
enter a serial number. The rendered image will appear 
as shown at right.  
 
Get Support

Product support is available to registered customers only from Red Giant Software, the 
publisher of Magic Bullet, Knoll, Digital Anarchy and Trapcode products. After installation 
of the software, your default browser will open and present you with the following page.

new Support page

Click on the Registration Form link to register your product. Alternatively, you can register 
with Red Giant Software by going to our Register page at 
http://www.redgiantsoftware.com/support/product-registration/ 

open a Support Case

The best way to contact support is through our Support Case form. We track all cases that 
come in to Red Giant Software. You can be assured of the quickest support response by fill-
ing out the form and providing the necessary details. Go to our Support page at  
http://www.redgiantsoftware.com/support/
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WhaT’S neW in VeRSion 2.7

CS5 Support

The biggest news is that Knoll Light Factory is now supported in After Effects CS5 
(Mac/Windows) and Premiere Pro CS5 (Windows only). The plug-in will run natively 
in 64-bit host applications and environments. 

Support for Motion is not included in the 2.7 update since Motion is not a 64-bit ap-
plication. 

new operations

Clicking in a rectangular color patch opens a color picker. On Mac, dragging in the 
color picker changes the associated color wheel and swatch. Dragging in the color 
wheel updates the color picker. On Windows, select a color in the picker and close it, 
then the wheel & patch update.

When a color picker is open, the color patch connected to it will have a red border.

The mouse wheel scrolls the element list when the cursor is over the list.

You can click and drag to reorder elements in the list, but so far as I can tell, it doesn’t 
make a visual difference in most cases.

The Delete button becomes inactive where there are no elements in the list.

The numeric parameters can be changed by mouse-down on them and dragging 
left and right, or by typing new values in once the field is open for editing by dou-
ble-clicking on it.

new Keyboard Shortcuts

Spacebar - Toggles enable of currently selected element
up/down arrows  - Selects previous or next element
escape - Cancels drag or Element menu if active. Clicks the Cancel button if nothing 
is active. 
delete - Deletes selected element.
enter or Return - Clicks the OK button.
option [Mac] or Ctrl [Windows] - Changes the Load... button into Append... 
opt/Ctrl-drag - Holding this button while dragging in a color wheel will speed up 
the drag.
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WhaT’S neW in VeRSion 2.5/2.6
With the release of Knoll Light Factory 2.5, John Knoll concentrated on adding 
the two most requested features to the plug-in: Native Mac OS X support and 
16-bit rendering. With the addition of 16-bit rendering, all of the plug-ins now 
can render in 16-bit, providing much smoother gradients in elements like Disc 
and GlowBall.

Knoll Light Factory 2.5 has been enhanced in 3 primary areas, a new GPU 
engine, a set of 25 new flare presets, and matte generation for outputting an 
alpha channel and new options for Light Factory Spectacular in After Effects.

new Features

Gpu engine. The new GPU engine in Light Factory 2.5 delivers up to 10 times 
the render speed of the CPU-based version, depending on the power of your 
graphics display card. In essence, the graphics processor is used to render and 
combine the flare elements and to deliver a final image to the host application. 
Because of the power of modern GPUs, rendering can be accomplished much 
faster than with a CPU alone. Greater speed is especially important for HD us-
ers. A GPU switch is available to turn this feature on and off.

new Flares. A new set of 25 flares have been added to both Light Factory EZ 
and as custom flares for use with the Light Factory Lens Editor. These flares em-
ulate suns and bright light sources from various cameras and add some basic 
graphic elements like twinkling lights and flash bulbs. In addition, all custom 
flares now feature an icon preview in the Lens Editor load dialog.

Matte Generation. All Light Factory plug-ins now offer built-in alpha channel 
generation. The new Unmult switch will allow the plug-in to output to an alpha 
channel for the flare. It is turned off by default to ensure compatibility with 
older projects.

Tip: If you are loading an old project, the new version is fully compatible with older 
versions of Knoll Light Factory. If you have a project that has multiple flares on a 
layer, you can delete the Unmult plug-in and simply turn on the Unmult switch on 
the last plug-in in the effects stack to get the same effect. The Unmult switch will 
not automatically change states to replace the old Unmult plug-in.

Spectacular Controls. Light Factory Spectacular now features an expanded set 
of controls for changing the flare brightness and scale depending on the alpha 
channel. 
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application updates 

Version 2.5 adds support for new hosts that were not available with previ-
ous versions. New host support includes Apple Motion (as a native FX Plug), 
Adobe Premiere Pro and Avid AVX Systems (AVX 1.5 compatible). 

new Common Controls 

The two main plug-ins, Light Factory and Light Factory EZ, support the same 
basic flare controls. The options for Adobe After Effects are largely un-
changed except that the Unmult and GPU controls have been added to the 
bottom of all plug-ins.

unmult.  This switch lets you turn on and off the generation of an alpha 
matte for the flare. When you apply the effects to a clip or segment, the flare 
will composite over the underlying tracks.

Gpu. The GPU render engine can be turned on/off with this switch. 

Track intensity. In Light Factory Spectacular, the Track Intensity pop-up has 
been added. This option controls the brightness and scale of the rendered 
flares at each output point.
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inTRoduCTion To LiGhTinG eFFeCTS
Camera lenses are complex devices. Most lenses contain many separate glass 
elements in order to form a sharp, clear image. While the function of a lens is 
to bend light onto the exposure surface, all the elements inside a lens reflect a 
small percentage of the light that strikes them. 

Anti-reflective coatings on the lens elements minimize these reflections, so that 
ghost images do not appear in the picture. The anti-reflective coatings reduce 
the brightness of the reflections to the point that they are too dim to photo-
graph. When a very bright light like the sun or a stadium light is photographed, 
the reflections themselves are bright enough to show up.

It is a misconception that lens flares are mistakes. Flares are frequently used to 
create an effect. Directors may test a variety of lenses to find one with a particu-
lar look to suit their style or provide a particular effect for a single shot.

Lens flares are the result of photographing bright lights either on film or video. 
When you think of all the great digital simulation tools available to us today 
to create realistic images, it is appropriate that we have tools to simulate lens 
flares as well.

Knoll Light Factory provides the tools to design and add extremely realistic lens 
flares. The individual flare elements can also be used to create vibrant motion 
graphics effects that go well beyond the typical lens flares found in most ap-
plications.
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KnoLL LiGhT FaCToRy oVeRVieW
Knoll Light Factory is comprised of a number of dif-
ferent plug-ins that you can use depending upon the 
desired effect and the time you want to put into lens 
flare design.

Light Factory plug-in 

Light Factory is the core plug-in of the Knoll Light 
Factory suite. Light Factory offers controls that let 
you create, edit, and animate your own custom light 
effects. 

It contains all of the controls and a custom flare editor, 
the Lens Editor, for building or applying the included 
flares, allowing you to create and edit your own cus-
tom effects. Light Factory offers all of the animatable 
Common Controls listed in this manual, no matter 
which host application you use.

Light Factory eZ plug-in

Light Factory EZ is a simplified version of the Light 
Factory plug-in described above. Light Factory EZ 
has the same animatable controls as Light Factory, 
but lacks the custom flare editor. Instead, you can use 
the Flare Type presets pop-up to add any of the 66 
included flares to your project. This is the quickest way 
to add a lens flare. This menu gives you quick access to 
any one of the 66 custom flares created by John Knoll.

Light Factory EZ is great for those occasions when you 
need to add a light effect quickly. Just choose one of 
the Lens presets and you are ready to go!
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Light Factory Spectacular plug-in (ae only)

In After Effects, you also get Light Factory Spectacular. This 
plug-in is similar to the Light Factory plug-in, with one big 
difference. Instead of tracking only a single point in a clip 
for location, it can be used to track an unlimited number 
of points. This applies a custom flare to multiple location 
points at once. 

This plug-in is particularly well-suited for use with particle 
system, and a great way to add shimmering particle effects. 

how it Works

Light Factory Spectacular analyzes the alpha channels of the selected source layer 
to find a position for each flare. Each white point corresponds to a position value 
when the light effect is rendered. The RGB channels are analyzed for hue and 
saturation information and this is used to color the light effect. 

Spectacular Source Layer showing alpha channel (left) and RGB channel (right)

Spectacular RGB layer (left) and Spectacular result (right)

In the example above, we see how the color of each of the small flares corre-
sponds to the color of the dot. In addition, the size of the white area controls the 
brightness and scale of the light effect—the larger the white dot, the greater the 
brightness and scale values become.
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Track intensity

Light Factory Spectacular has a Track Intensity pop-up for controlling the bright-
ness and scale of the rendered flares at each output point. There are three options: 
Brightness, Scale, and Scale and Brightness.

The flare output can vary in 3 different ways. The following 
images show the results with each of the modes selected.

  

In this example, Spectacular only varies the Brightness where small dots generate 
dim flares and large dots generate bright flares.

  

In this example, Spectacular only varies the Scale at each point where small dots 
generate smaller flares but the brightness remains fixed.

  

In this example, Spectacular varies both the Brightness and Scale at each point where 
small dots generate small dim flares and large dots generate bigger and brighter flares.

Tip: Version 2.0 of  Spectacular only varied the scale of the flare based on the infor-
mation in the RGB + Alpha channels.  
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individual element plug-ins (ae only)

In After Effects, Knoll Light Factory also includes 19 
individual light effect elements as separate plug-ins. 
By using these Element plug-ins, you have keyfram-
able control over the elements. This offers greater 
animation control, unlimited motion graphic ef-
fects, and the power to create light effects that go 
beyond flares. 

The Element plug-ins offer nearly the same range of 
fetures as the Light Factory plug-in. Each light effect 
has animatable parameters specific to that type of 
effect.

For example, the group of plug-ins that shimmer as 
the Angle value change, e.g. the LF Sparkle plug-in 
offers an angle parameter that you can keyframe. 
Only flares capable of this shimmer effect offer the 
angle parameter. The Element Parameters section 
describes the individual element parameters in 
greater detail. Two Element plug-ins, LF Sparkle and LF 

Aperture Reflection.
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CoMMon paRaMeTeRS
The two main plug-ins, Light Factory and Light Fac-
tory EZ, support the same basic flare controls. Light 
Factory Spectacular also has most of these controls. 

These parameters are discussed according to their 
operation in After Effects. This manual also covers 
any differences in operation in other host apps. 

brightness

The Brightness slider controls the brightness of the 
effect. Brightness causes the center of the flare to in-
crease in size as it blooms or pushes towards white.  
A brightness value of zero is handled as a special 
case and does not render. You can use this feature 
to turn the flare on and off during an animation.

Scale

The Scale value adjusts the size of the individual lens elements. The scale 
control will increase the overall size of the flare elements without brighten-
ing the flare. It does not change the position. You can animate the scale to 
simulate the adjustment of the focal length of a zoom lens.

 

brightness of 100 (default) versus 150

Scale values of 1.0 (default) and 3.0. Note the ray size.
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Light Source Location

The position of the light source can be controlled in two ways, either by ani-
mating the Light Source Location point control or by specifying a light source 
location layer. 

The position control lets you numerically set the center point for the flare. You 
can also change the values by moving the cross-hair or point control in the 
preview window in the host application. In the Avid version, the Light source 
Location is called X,Y but works the same way.

You can animate the Light Source Location value to place the center of the 
flare at a precise location on each frame. For example, the image below shows 
the lens flare at its default location (pixel values 192, 144), and after its posi-
tion has been moved to 448, 336.

Light Source Location

Color

The color control specifies the color for the light source. To simulate an blue 
light, set the color to blue. 

Color using white (default) and 100% saturated blue
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Only hue and saturation values are used from this color sample. A bright blue and 
dark blue color will result in the same image. Also, using neutral colors such as 
dark gray or black will not darken the flare.

You can set a color to override the flare element’s individual colors. As you increase 
the color value saturation, the color will override the flare element’s color.

angle

These custom elements will appear to shimmer when you animate the Angle 
settings: Random Fan, Photon Spikeball, PolySpikeBall, and Sparkle. Add different 
keyframe values at the beginning and end of the flare’s appearance to create this 
effect.

Each flare element can change or rotate about the Light Source Location point. 
Some of the individual elements like the Star element will rotate in place as this 
value changes.

Angle showing 0° (default) and +11°

Tip: This Angle control is not related to the angle control found in the Lens Editor. The 
Angle control will not rotate lens elements. However, the element angle value will 
change the flare spikes when used with the Individual Effects filters.

Location Layer

The Location Layer allows you to set a layer where the Light Factory plug-in will 
attempt to extract a position for the filter. This setting will override the Position 
settingwhen enabled. When the Location Layer popup menu is set to None, Light 
Source Location is used to set the position of the effect. 

Here is how this works: Light Factory searches the alpha channel of the layer you 
set in the pop-up for any non-black pixels and attempts to calculate the average 
position of these pixels. If you have a small white dot in an otherwise black alpha 
channel, Light Factory will determine the position of the center of the dot and 
place the light effect at that location.
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Location Layer dot (viewing the alpha channel) and flare

The image on the left shows a sample alpha channel that can be used to position 
the flare. The image on the right shows the corresponding flare with this image 
set as the location layer. 

This technique works when a single dot appears in an alpha channel, but it will 
not track multiple dots and attach flares to each—this feature is available in the 
Light Factor Spectacular filter described in the Light Factory Spectacular section.

Tip: When an alpha channel image used as a location layer contains multiple dots, 
the plug-in will average the positions of each dot. The location layer does not need to 
be visible for Light Factory to use it as a positioning layer. If no non-black pixels exist 
in the alpha channel of the specified layer, the light effect will default to the center of 
the image.

obscuration Layer

The Obscuration Layer pop-up menu is used to choose a layer that will obscure 
or hide the flare, making it appear to pass behind objects in another layer. For 
example, you could make a flare that represents the sun flickering appropriately 
as it passes behind tree branches. 

No obscuration layer (left) and obscured by plane (right)
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The image above is taken from the Air Knoll tutorial in the Tutorial section. On the 
left, no obscuration layer has been set and the sun appears to be in front of the 
plane. On the right, the obscuration layer has been set to the diffuse plane layer, a 
layer that contains an alpha channel that follows the contour of the plane. 

Because the position of the flare is very close to the edge of the alpha channel, 
the flare is partially obscured. The Light Factory filter is able to create very realistic 
simulations of a light passing behind an object using the obscuration layer control.

obscuration Type

The Light Factory plug-in offers four options for the information used by the ob-
scuration control.

alpha is the default obscuration type. Pixels with an 
alpha value of zero or black let the flare show through. 
Pixels with an alpha value of white completely obscure 
the flare. Pixel values between zero and 255 scale the 
obscuration by a corresponding amount.

inverse alpha is produces the same result as the alpha choice but white and black 
are inverted.

RGb modulates the color of the light effect with the corresponding RGB value of 
the obscuration layer. It is possible to simulate the sun shining through a stained 
glass window by moving the light flare over the color area. 

No obscuration layer (left) and obscuration layer on, type RGB

Tip: The RGB color change is added to any color the light effect might have, so a yellow 
flare passing through a cyan-colored RGB obscuration layer will result in a green flare.

RGb + alpha type combines the effects of the RGB and alpha types where trans-
parency of the light effects is controlled by the alpha channel and the color is 
altered by the RGB channels just as in RGB type shown above.
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Source Size

Source Size is only used when an obscuration layer is set—the source size does 
not otherwise change the size of the light source. The Source Size value controls 
the search area averaging around the current light source position. 

If the source size value is 2, Light Factory will examine the obscuration layer in a 
2-pixel radius around the light source for obscuring values (white or black). This 
means that if 20% of the pixels inside that radius are obscured, the brightness of 
the flare will be reduced to 20%.

unmult

This switch lets you turn on and off the generation of an alpha matte for the flare. 
When you apply the effects to a clip or segment, the flare will composite over the 
underlying tracks.

Gpu

The GPU render engine can be turned on and off with this switch. 

Motion blur plug-ins

Some host applications, such as Adobe After Effects and Pinnacle Systems’ Com-
motion, can simulate motion blur for moving elements in a layer. If the motion 
blur switch is on in the host application, Light Factory will apply motion blur to 
the light effect, providing more realistic results in some cases.

Moving flare with motion blur off (left) and on (right)
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Lens Editor for versions 2.5/2.6, showing GlowBall. Lens Editor for version 2.7, showing GlowBall.

LenS ediToR
In the Light Factory and Light Factory Spectacular plug-
ins,  under the Options button lies the Lens Editor. This 
is the heart of Light Factory where you can combine the 
different elements. 

No matter which host application you use, the Lens Editor interface will look similar to the 
screen shot. The Lens Editor contains three sections: the Preview area, the Elements (i.e., 
lens primitives) list, and Element Parameter controls. 

There are three main parts to the Lens Editor. There is the Preview Window, the Element 
Parameters and the Elements List. We talk about each in the following sections.
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pReVieW WindoW
The preview window is only for designing the light effect. The control triangles on 
the right and bottom let you see how the light effect will appear once it is applied. 
You can preview how the lens will respond to color and brightness changes using 
the global brightness and color sliders but these changes will not be reflected in the 
main plug-in interface.

The Preview window shows the combined elements and gives you controls to test 
the effect of brightness, color, position, and scale changes. The brightness, color, 
position and scale controls are not linked to the main interface and will not update 
the corresponding parameters in the main plug-in. These controls are provided so 
you can better evaluate their effect without leaving the Lens Editor interface.

Preview Window in Lens Editor 2.5/2.6

Fast drags

The Fast Drags check box switches the preview render to half resolution as you drag 
the position triangles. On older machines, or when working with many primitives, 
this will make the preview update faster.

Clipboard display button

If you have an image on the clipboard, clicking on the Clipboard Display icon will 
display that image in the preview window but only while you click and hold the 
mouse on the button. This is useful for matching the flare position to an image.

Preview Window in Lens Editor 2.7
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eLeMenTS LiST
The column below the Load and Save buttons shows all of the elements cur-
rently added to the effect. You can add, copy, delete, rename and reorder the 
elements using the list view.  

By default Light Factory creates and adds a GlowBall, PolySpread and StarFilter 
to the list of elements. You do not need to use this particular set elements or 
the combination. Feel free to add, modify or delete these elements entirely to 
create your own effect.

Elements List, versions 2.5/2.6 

duplicating elements

You can duplicate an element in the Elements list by dragging it onto the 
Custom Effect icon.

deleting elements

There are two ways to remove an element from the list (and from the effect). 
Either select the effect and click the trash can icon, or drag and drop the ele-
ment onto the trash can.

Elements List, version 2.7
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Selecting elements

You can select an element by clicking on its name in the Elements 
list. This highlights the name of the element, and makes any spe-
cific parameters of that element appear in the Element Parameters 
section.

adding elements

You can quickly generate new light effects by clicking on the Cus-
tom Effect popup menu—located below the elements list, it looks 
like a blank sheet of paper—and selecting a new element type. 
The new element is added to the Elements list, and selected so it 
shows its available parameters. You can add up to 100 elements 
to any single effect. Usually, you will only need 5-10 elements to 
make up a realistic effect.

Visibility Checkbox

You can use the checkbox next to each name in the element list to 
turn on and off the use of that element. This is useful for working 
on copies of an element or comparing two or more similar ele-
ments with different parameter values.

Renaming elements

Each element inherits its name from the element type. To rename 
an element, double-click it in the list.

Reordering elements

To reorder elements in the list, simply click and drag. A dark line 
will appear as you drag up and down the list.

Tip: The rendering order is not significant and will not change the 
look of the rendered light effect. Reordering elements is a convenience 
that you can use to group elements by color, scale or other attribute.

Elements pop-up, versions 2.5/2.6

Elements pop-up, version 2.7
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eLeMenT paRaMeTeRS
The Element Parameters section displays the controls for the selected 
element. If you do not select an element, this area of the interface will be 
blank. 

The area will update as you select an element in the List. The value changes 
made to each element will be reflected in the preview and in the final ap-
plication of the light effect. 

Elements Parameters for Photon SpikeBall, versions 2.5/2.6

Elements Parameters for Photon SpikeBall, version 2.7

Different elements have different parameters, so only some of the sliders 
will be enabled. Each slider control differs a bit from element to element, 
so the slider labels will change as you highlight different element types. As 
you drag the sliders the preview window will update in close to real time.

Tip: In After Effects, you can use the individual Element plug-ins when you 
want to animate the element parameters. See next section of this manual.



Knoll Light Factory manual

28  ©2010 Red Giant Software

element parameters & individual effects

The controls listed for each lens primitive in the Element Parameters sec-
tion are duplicated in the individual Element plug-ins. On the previous 
page, the Element parameters for the Photon SpikeBall is similar to the 
animatable controls shown below in the Photon SpikeBall plug-in. 

Each plug-in has the following parameters: brightness, scale, color, loca-
tion layer, obscuration layer, obscuration type and source size, that are 
the same as the main Light Factory plug-in. Listed below the source size 
are the Element-specific parameters, where the specific element con-
trols are ususally begin with word ‘element’. 
 

LF Photon SpikeBall plug-in 

There is no difference in the rendered results whether you use the Lens 
Editor or the individual plug-ins to create a light effect. With the indi-
vidual plug-ins you get the ability to animate all of the values making 
the individual plug-ins useful for creating shapes such as a disc or a 
starburst without having to build a simple custom flare.
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Load and Save buttons

Custom lenses can be saved to disk and loaded again for reuse. If you 
hold down the Option key when you click the Load button, the custom 
lens file you select will be appended to the end of the current list, rather 
than replace it. This feature lets you create partial libraries, say of just lens 
centers, or just reflections, and then combine them with Option-Load.

oTheR LiGhTinG eFFeCT TopiCS

What is the meaning of ‘position’?

Most of the custom effects have a position parameter. This position is always along a 
line that passes through both the center of the image and the light source. A posi-
tion of 1.0 places an element at the light source. A position of 0.0 places an element 
in the center of frame, and a position of -1.0 places an element on the opposite side 
of the frame from the light source.

When should you use anamorphic flares?

Anamorphic flares (those with wide elliptical elements rather than circular elements) 
only happen with anamorphic lenses, and anamorphic lenses are used to shoot 
wide-screen motion pictures. Super35 and 16mm motion pictures, and film shot 
with television and video cameras use ‘flat’ lenses. 

It is not technically correct to use an anamorphic flare in a Super35 film or a televi-
sion show. Similarly, the blue horizontal stripe seen in many anamorphic flares is an 
artifact of the way anamorphic lenses are built, so you won’t see them in film shot 
with flat lenses.

Star filters & polygonal reflections

There is a relationship between f-stops, polygonal reflections and star filters. A lens 
that is ‘wide open’ (f-stop set to its minimum value) usually exhibits circular reflec-
tions, but as the aperture closes down, the shape of the aperture changes the reflec-
tions to polygons, and a ‘star filter’usually appears at the source.
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automatically track the light source position

One of Light Factory’s most powerful features is its ability to automatically 
calculate the position of a light effect by tracking an area of the alpha 
channel of any clip in the composite. 

You’ll notice several similarly-named elements in this manual’s tutorials 
(i.e. suntrack.mov, etc.) These were generated within ElectricImage by 
placing a small sphere into the scene— usually in the same location as 
the light source—and rendering it out as a separate element. The white 
dot in the alpha channel of this element represents the correct position of 
the light source throughout the length of the clip. 

Figuring out this location and animating it by hand in the host applica-
tion would be incredibly difficult and time-consuming. By setting Light 
Factory to automatically track the layer, the center point of the white dot 
in the alpha channel will denote the location of the light effect on that 
frame, and its position will automatically animate throughout the scene.

auto-obscure the light source for realism

The Auto-Obscure feature is a fantastic effect that automatically creates 
animation in the brightness of your flare by taking into account another 
layer’s alpha, allowing you to simulate a flare going ‘behind’ objects in the 
scene. As your flare position moves behind obscured areas of an alpha, 
the flare will automatically dip in brightness as if obscured. As you’ll see in 
the Stained Glass tutorial, you can even have the flare take on color tinting 
as if moving behind a colored pane of glass.
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eLeMenTS
The following is a list of all the Lens primitives or elements avail-
able in Knoll Light Factory, with a brief description of each. The 
best way to understand each elements may be to experiment with 
the settings of each element.

Glowball

The basic primitive used in most flares and effects. The glow rep-
resents the overexposure and light scattering that a bright light 
source creates when focused through a lens onto an image plane. 
You can control the color and scale of the glow, as well as the 
rendering of a characteristic red ring associated with a bright light 
source. Parameters are available to control the ring scale, bright-
ness and softness.

Spikeball

Most lenses exhibit at least a little bit of radial streaking from 
the light source, and the Spikeball simulates this. The lines in the 
Spikes appear as random lines from the center of the ball. You 
have control over the scale, brightness, density, color, rotation, and 
the random seed used to generate the spikes.

polygon Spread

The polygonal opening of a bladed aperture can also cause many 
polygonal reflections to appear on the exposure surface. The 
Polygon Spread element creates a number of randomly positioned 
polygonal reflections, each with a different brightness and random 
hue. 

Since these reflections are created randomly, there are three differ-
ent random seeds used to vary the look. You also can control the 
scale, brightness, number of sides, quantity, position, and color of 
the polygons.
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Circle Spread

Like Polygon Spread, Circle Spread lets you create a number 
of randomly sized and positioned circles. The controls are 
similar to those in the Polygon Spread element. Circle Spread 
is useful for making the tiny dots and small circles that ap-
pear in lens flares.

elliptical Caustic

The Elliptical Caustic filter simulates a unique distorted re-
flection observed primarily in Nikon still camera lenses.

Star Caustic

This diamond-shaped caustic is useful for simulating reflec-
tions caused by reflective coatings. You will notice that the 
default values cause a barely visible green shape.

Faded Ring

Faded Ring generates a “rainbow ring” effect that fades out 
toward the edges of the frame.

Stripe

Stripe renders a tapered line with adjustable color, width, 
angle, brightness and position. Many anamorphic lenses 
exhibit a blue horizontal streak through the center, and some 
video cameras exhibit a reddish vertical streak through the 
center.
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Random Fan

RandomFan generates an attractive asymmetrical fan of 
spikes with many radial lines. RandomFan responds to the 
angle control with a subtle shimmering of the lines.

polySpikeball

PolySpikeBall creates an effect similar to RandomFan but 
with much wider areas of light and dark. The filter tends to 
render much faster than RandomFan element and this might 
produce an acceptable alternative much more quickly.

photonSpikeball

As the name implies, this effect generates a “Photon torpedo” 
effect as seen in several of the science fiction films that John 
Knoll has worked on over the years.

aperture Reflection

Most film cameras will exhibit some aperture reflection. In a 
film camera, the film passes through the movement, where 
it is exposed to light. The movement has a rectangular hole 
called the gate. The focused image from the lens shines 
through the gate and onto the film. In most cameras, this 
aperture is polished stainless steel, and is highly reflective. 

When the focused image of a bright light gets close to or 
slightly outside the edge of frame, the image can reflect off 
of this shiny surface back into the image causing an aperture 
reflection.

Tip: Note that you will not see the effect unless the light source 
location is outside the edge of the composition or frame.

Chromahoop

Chroma Hoop creates a circle of rainbow lines that streak 
through the center of the light source. This type of effect is 
frequently seen on film shot in Super35 format.
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Single polygon

The Single Polygon filter is appropriately named with complete 
controls for generating a single polygon shape. You can control 
the position, brightness, color, size, number of sides, softness, rota-
tion, and the degree to which it varies in brightness as it moves 
from the center of frame to the edge.

disc

The Disc gives you precise control over the generation of a single 
circular ramp effect. You can control the position; size; color; 
brightness; three separate controls for the inner, middle and outer 
gamma; and taper and center offset controls that change the 
shape of the disc.

ellipse

Ellipse is like Disc, except that the shape is elliptical, not perfectly 
circular. In general, the glow at the light source is circular, and 
reflected elements are elliptical.

Sparkle

Sparkle generates a number of short linear streaks radially distrib-
uted about the center. The streaks change with the angle control 
by appearing closer or farther from the center of the source loca-
tion. The Unidirectional checkbox limits the motion to all inward 
or all outward (depending on what direction the angle control is 
moving). This effect can simulate the sparkle you see when a laser 
is pointed into a camera lens.

Chroma Fan

Chroma Fan generates rainbow diffraction patterns. These pat-
terns often appear when a net is used for diffusion over the lens, 
or when there is fog or mist in the air.
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Starfilter

Most lenses contain multiple bladed apertures to allow more 
or less light to pass through the lens, controlling the exposure 
of the film or video CCD. In most lenses, when the aperture is 
wide open the opening is perfectly circular, but as the lens is 
“stopped down,” the opening becomes a smaller polygonal 
shape. 

For example, a five-bladed aperture will create an opening 
with five sides as the lens is stopped down. This is why you 
often see pentagonal or hexagonal shapes on a lens flare. 

The aperture also reflects light where the blades intersect, 
creating a star filter effect. For example, a partially closed five-
bladed aperture will reflect five streaks, and result in a ten-
point star on the exposed surface. 

The StarFilter lets you simulate this effect. You can control the 
size, brightness, color, number of points, width and rotation.
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uSinG KLF 2.6, 2.7 in aFTeR eFFeCTS (MaC/WindoWS)
The After Effects version of Knoll Light Factory is the most complete of all 
host applications. In addition to the Light Factory and Light Factory EZ 
plug-ins, there is a Light Factory Spectacular plug-in and individual Ele-
ments plug-ins.

To use the plug-ins, apply them to a layer source by choosing a Layer> 
New> Solid item, then setting that solid to black. Alternately, apply the 
plug-in to an image source. You will see the flare appear in the Project 
Preview viewer. To access the plug-in parameters, click the Effect Controls 
panel.

To access the Lens Editor, click the Options link at the top of 
the plug-in. The Lens Editor is standard through all host ap-
plications.

After Effects interface showing the Light Factory plug-in.

Tip: To access the 16-bit rendering capabilities in Light Factory, 
you will need the After Effects Production Bundle version. In 
After Effects, open the Project WIndow, then Option-click [Mac] 
or Alt-click [Windows) in the bit-depth control to switch the 
project rendering to 16-bit mode.

Access the plug-ins from Effect 
Controls panel.
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uSinG KLF 2.5.5, 2.7 in pReMieRe pRo (WindoWS)
The Premiere Pro version of Knoll Light Factory contains the same controls 
and features as found in After Effects. 

To use the plug-ins, apply them to a clip in the sequence. You will see the 
flare appear in the Project window. To access the plug-in parameters, click 
the Video Effects panel.

To access the Lens Editor, click the Options icon. The Lens Editor is standard 
through all host applications.

Premiere Pro interface showing the Light Factory plug-in. Access the plug-ins from Effects> 
Video Effects panel.

options
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Create a premiere pro transition 

The following is a step-by-step instruction for applying Knoll Light Factory EZ in 
Premiere Pro as a transition.

1.   Start by creating a new NTSC DV project. These settings will work for PAL or HD as 
well, but the timing and center points will need to be changed. 

2.   We will start by creating two generic titles on video track 1. Choose File> New> 
Title... and give the title a name (My Title 01). The Title editor will appear. Enter 
your text and click the upper-right close box.

    

     My Title 01 in the Title Editor

3.   Create a new Black Video clip to apply the Light Factory filter to by choosing File> 
New> Black Video. Choose the Black Video item in the Project window and set 
the duration by choosing Clip > Speed/Duration. In the dialog, set the duration to 
1:00 second and click OK. 
 

    Speed/Duration change for the Black Video 
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4.   In the Project window, select your first Title item (My Title 01) and choose Edit > 
Duplicate to create a new Title file. Premiere Pro will name the file Title 01 Copy. 

    

    The Project window showing the duplicated titles 

5.   Drag and drop these 2 title cards onto Video 1 in the Sequence window. You 
should now have a timeline with two titles. To create the transition, drag and drop 
the Black Video onto the Video 2 track and center it between the two Title clips.

    

    Two titles and a black video slug on the Premiere Pro Timeline

 
6.   Open Knoll Light Factory from the Video Effects category. Add the Light Factory 

EZ effect by dragging and dropping it onto the Black Video clip on Video 2.

     

    Add the filter effect to the Black Video on the timeline
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7.   Click the Black Video clip and reveal the Effect Controls window. This will show the 
Light Factory EZ controls. Center the flare in the Program window by entering the 
center coordinates 360, and 240 in the Light Source Location control. Choose the 
Bright Eye preset from the Flare Type pop-up menu.

     

      The settings for Light Factory EZ at the beginning of the animation

 
8.   The flash effect is created by adding keyframes to the Brightness and Scale controls. 

Move the play head to the beginning of the effect by setting play head to the left side 
of the Effect Controls window.

9.   Click the stopwatch next to the Brightness and Scale controls to set initial keyframes, 
then change the Brightness value to 0, and Scale to 0.1. Move the play head to the 
middle of the Effects control window (ahead 15 or so frames), change the Brightness 
value to 150.0 and the Scale to 2.0. Finally, move the play head to the right side of the 
Effect Controls window and set the Brightness value to 0 and the Scale to 0.1. Choose 
loop from the Program window and press Play to preview the result. 

     

    Light Factory in the Effect Controls window with applied keyframes
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uSinG KLF 2.6 in FinaL CuT pRo (MaC)
The Final Cut Pro version of Knoll Light Factory contains the same controls 
and features as found in After Effects. 

To use the plug-ins, apply them to a clip in the Timeline sequence. You will 
see the flare appear in the Canvas viewer. To access the plug-in parameters, 
click the Filters tab in the Viewer. 

To access the Lens Editor, click the Options button. The Lens Editor is stan-
dard through all host applications.

Final Cut Pro interface for the Light Factory plug-in.

Tip: In Final Cut Pro, you may want to apply the effect to a Slug with a black 
color. Change the Slug item properties in Final Cut Pro to Screen and you will get 
the same result as you would in After Effects when Knoll Light Factory is applied 
to a black-colored solid. Since Final Cut Pro does not render in 16-bit mode, there 
is no way to access this rendering mode inside Final Cut Pro.

Access the plug-ins from Effects> 
Video Filters bin.
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uSinG KLF 2.6 in MoTion (MaC)
The Motion version of Knoll Light Factory contains the same controls and 
features as found in After Effects. Only the Tracking and Obscuration features 
operate differently in Motion (see next page). 

To use the plug-ins, apply them to a layer source by choosing a Generators> 
Color Solid item, then setting that solid to black. You will see the flare appear in 
the Project Preview viewer. To access the plug-in parameters, click the Inspec-
tors> Filters tab.

To access the Lens Editor, click the Options button. The Lens Editor is standard 
through all host applications.

Motion interface showing the Light Factory plug-in. 

Access the plug-ins from Library> Filters panel.

The proper layer order in Motion.
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Tracking

To create a layer as a tracking source, make sure that the layer is the same 
size as the current project. This can be accomplished by placing a solid on the 
tracking source layer and then dragging the layer into the Tracking source well.

obscuration

To properly  create an obscuration effect in Motion, the 
obscuration layer must be the same size as the project 
document. You must use a full size layer with an alpha 
channel. 

Just using a Text object will NOT work with the obscura-
tion feature and the flare will not change as it animates 
behind the Text. Text Layers and other objects do not 
provide enough information to the plug-in to properly 
obscure a flare. 

A properly constructed obscuration layer in 
the Timing panel of Motion.
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build a Flare animation in Motion

The following steps will show you how to construct an obscuration layer in Motion. 

1.   Set the Flare Type in the Light Factory EZ Filter window to Gold Spikes. Set the color 
to a bright red (Red = 255, Green=45, Blue=51)

    
    The Gold Spike flare applied in the Motion project window

2.   Start by animating the flare position. With the Light Factory EZ flare interface visible 
in the Inspector, set the x, and y values for the Light Source Location control to -280, 
and 0. Option-click the keyframe control to set a keyframe.

    

     The Light Source Location control set to -280, 0 and keyframe set 
 
3.   Move the play head to frame 90, and set the Play Range Out to the current time 

(Mark > Mark Play Range Out) to constrain playback to first 3 seconds. 

4.   With the Light Factory EZ flare interface visible in the inspector, set the x, and y value 
for the Light Source Location control to 280, and 0. Option-click the keyframe control 
to set a keyframe.  Now there are two keyframes, the flare should animate from left 
to right across the screen. Hit play to view the animation. When finished with play-
back return to frame 1.
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     The Light Source Location control set to -280, 0 and keyframe set  

5.   Now we are ready to add some text and set up the obscuration layer control. Create 
a new Layer (Object > New Layer) and rename it to Text Layer.

6.   Drag and drop a new Color Solid into the new layer and snap the solid to the center 
of the layer. With the Dashboard open, click the color swatch for the Color Solid. By 
default this is a bright blue. In the Color picker, change the color to black. This solid 
will be used to create the full size image that Light Factory needs to properly analyze 
the alpha channel. 

Tip: To work properly in Motion, Light Factory requires that the obscuration layer be the 
same size as the project document. Just using a Text object will NOT work with the obscu-
ration feature and the flare will not change as it animates behind the Text. 

7.  Create a Text Object in the center of the screen on top of the flare animation. 

      

 
     Light Factory EZ with obscuration of a flare in the project window
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8.   With the Color Solid selected in the Timing panel, choose Object > Add Image 
Mask. Drag and drop the Text Object into the Mask Source well in the Inspector 
panel or Dashboard interface for the Image Mask.

 

     Motion Timing window showing final layers and Red Giant text object on

 
9.   By default Motion turns the text object off but we still want to see the text so click 

the visibility checkbox to on in the Timing panel.

10.  Finally, click the Light Factory EZ interface in the Timing window to show the inter-
face for the obscuration layer and then grab the Text Layer (NOT the Text Object) 
and drop it into the Obscuration Layer control. This will then direct Light Factory 
to hide the flare or shrink the scale and brightness when the Light Source Location 
is underneath the text.
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Avid interface showing the Light Factory plug-in. 

Tip: The AVX Mac plug-in requires 10.4.3 which means that only Xpress Pro 4.8 and 
later is supported. Avid XPress Pro 5.5 is not currently supported because of AVX SDK 
changes but an update is planned.

options

uSinG KLF 2.5.5, 2.7 in aVid (WindoWS)
The Avid version of Knoll Light Factory contains the same controls and features as 
found in After Effects. 

To use the plug-ins, first create a black opaque title using the standard Title tool. Place 
the title object from the bin onto the timeline. Then from the Effect Palette or Effect 
Bin, Option-drag the Light Factory plug-in onto your Title. This will nest the effect on 
top of the title segment. You will see the flare appear in the Preview window. 

To access the Lens Editor, click the Options button. The Lens Editor is standard through 
all host applications.
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TRy KLF in phoToShop & apeRTuRe
If you like using Knoll Light Factory in video applications, then you will 
love it inside Photoshop and Aperture. Knoll Light Factory Photo 3.0 adds 
flare and sparkle to any photograph or still image.

KLF Photo creates photo-realistic or enhanced lighting effects. You can 
easily construct naturalistic lens flares by combining any of the 19 differ-
ent elements that occur when photographing lights and bright objects. 
Other features allow you to create lens flares, model man-made lights, or 
add glows to existing objects. 
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abouT The TuToRiaLS
All the tutorial projects that accompany Knoll Light Factory include:

•  A completed Adobe After Effects project containing all the original com-
posite elements.

• Test renders of each tutorial.

•  Custom lens flare settings files (Windows versions have a .lfp extension).

The nine tutorials were created and written by John Knoll, and therefore 
use the first person.

Leverage your 3d application

Most of the tutorials included here are a combination of ElectricImage and 
After Effects work—the elements were rendered in EI, then brought into AE 
for compositing. By having the individual layers available for tweaking in 
After Effects you afford yourself much greater control over the composite, 
and can make subtle changes without the need fortime-consuming re-
rendering inside a 3D application.

apply your flares to black solids

As you will see in the tutorials, John Knoll usually applies his light effects to 
black solids, created as layers within After Effects. Use the screen mode on 
these solids to composite the light effects into the scene, or use Unmult to 
generate an alpha channel for the solid. Applying the flares to a black solid 
instead of the source footage gives you a finer degree of control, as the 
flares are isolated into their own layer. 

Another handy trick is to apply the light effect to a solid that is half the 
resolution of your comp, then scale the solid 200% to match the size of the 
original composite. This scaling will soften and add subtlety to the light 
effect, often making it appear more natural.
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TuToRiaL 1: aiR KnoLL

In this scene the airplane elements were created from a 3D 
model of a DC-10 that I downloaded from the Internet. 
I painted the texture maps in Photoshop, then rendered sepa-
rate passes in ElectricImage for both the diffuse plane body 
and the reflections. Doing so allowed me precise control over 
the final look of the plane, by mixing the two layers together in 
After Effects. 

The movement of the sun is also generated in ElectricImage. 
I also had EI generate a flare location element, comprised of a 
white dot representing the position of the sun throughout the 
camera move. 

In the Light Factory settings for the composition, you’ll notice 
that the light source is set to automatically track the location 
layer, and to be obscured by the alpha channel from the air-
plane element. As you will see, this enables the sun to disap-
pear behind the nose of the plane at the end of the shot.

background plate, bg.mov

airplane Reflections, reflections.
mov

airplane diffuse, diffuse.mov

Location Layer, sun.mov

This shot is built by combining the three rendered images of the DC-10 with the flare 
layer and the sun location layer. Open the Air Knoll.aep file to see how the flare disap-
pears behind the airplane as the sun layer dot moves across the background.

The Elements listed above are combined in the Air Knoll composite. Use the RAM play 
option in After Effects to preview the shot. If you reveal the Light Factory effect in the 
Flare Layer, you can see how the flare is set track the sun.mov and is obscured by the 
Airplane diffuse layer.

elements
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TuToRiaL 2: anGLe aniMaTion

I created this project to illustrate the use of the rotation parameter within Light Factory. 
When creating light burst elements such as these, or photon torpedo-like effects, it’s 
important to animate the rotation variable of the flare. The rotation adds an incremental 
random variability to the light source, which simulates atmospheric interference or paral-
lax shifts.

Open the Angle Animation.aep file to see the flares in action. Simply do a RAM play and 
you will see how the Blue Photon and Orange Sparkle flares (the bottom flares in the im-
age above), show great variation as the angle parameter animates.

To see how the different elements react as the angle parameter changes, open the Angle 
Animation timeline. Click the Flares layer and hit the ‘U’ key to reveal just the parameters 
with keyframes. Each of the flares applied to the layer has keyframe animations for the 
angle parameter with a value of 0 at time 0:00:00:00 and a value of 47.6 at time 0:00:03:29.

Because the four different flares are made up of different flare elements or primitives, 
their appearance may vary only a little, as is the case with the Gold Spikes flare, or a lot, as 
with the Blue Photon. The Gold Spikes flare is made by a single spikeball primitive which 
changes only slightly as the angle parameters vary. The Blue Photon is built to vary great-
ly as the angle value changes. This causes the rays to change location on every frame.

Experiment with the different values for position, brightness, scale and color to see how 
the flare appearance can change.
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In this composite, Explosion.aep you’ll notice that all the light 
and explosion flashes are animated from within Light Factory. 
The 3D elements from Electric Image include the hapless tea-
pot, the explosion debris, the star field, and a tracker element 
for automatically tracking the position of the explosion core. 

There are two black solids in this comp to which I applied the 
Light Factor filter—one for the  
photon torpedo, and one for the flash and shock wave of the 
explosion. The photon torpedo gets its flickering movement 
from the animation of the angle parameter. If this parameter 
did not change, the radial shards would appear frozen and 
would not move.

The shock wave consists of a simple disc element, with an ani-
mated scale value to simulate an expanding shock wave from 
the explosion. The explosion flash consists of a simple light 
effect with a number of brightness keyframes. You’ll find that 
Light Factory is incredibly useful for creating flash and hot-core 
elements for explosions.

The elements on this page were used in Explosion.aep.

TuToRiaL 3: eXpLoSion

Teapot, teapot.mov

explosion, pyro.mov

Teapot Tracker, track.mov

Star Field, stars.mov

elements



Knoll Light Factory manual

53  ©2010 Red Giant Software

I created this tutorial to demonstrate the extent to which the 
auto-tracking and auto-obscuration features of Light Factory 
can be used to automate animation. All animation of the 
light effects is derived automatically from the source images.

I generated the red and blue light elements in Electric Image 
by rendering them as one sided objects. As these objects ro-
tate away from camera they do not generate any white pixels 
in the alpha. Each instance of the light effect uses one of the 
light elements both for location and obscuration. Since we 
want to see the light effects only when the light source is vis-
ible, we haveset  the obscure mode to inverse alpha.

The elements shown here were used to generate the flashing 
lights of the police bar.

TuToRiaL 4: poLiCe baR

blue Light Tracker, blue.lights.mov

police Car bar, bar.mov

Red Light Tracker, red.lights.mov

elements
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TuToRiaL 5: ReaLLy biG CoRp

I created this shot to illustrate a common problem. Notice 
that the right most light source emerges from offscreen—
right towards the middle of the shot. In order to get the 
aperture reflection (a custom effect that generates an edge 
flare as a light source appears from offscreen), I needed to 
create a black solid that is oversized—bigger than the real-
lybig.mov element.

The elements on this page were used in the creation of Re-
ally Big Corp animation. Note that the Light 1.mov and the 
Light 2.mov files contain the tracking information in the 
alpha channel of the movie file.

Light 1 Tracker, light1.mov

Really big Corp, reallybig.mov

Light 2 Tracker, light2.mov

elements
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Stars, stars.mov

Sun Tracker, sun.mov

Saturn, saturn.mov

This comp illustrates Light Factory’s auto-obscuration and 
auto-tracking capabilities, but with a little added twist.

In the After Effects project you’ll notice a black solid with 
two Light Factory effects applied. Both light effects use the 
file sun.mov for their screen location, and the alpha chan-
nel of saturn.mov for obscuration. While the primary light 
effect uses the alpha channel of saturn.mov to control its 
brightness (to dim the simulated sun as it is obscured by the 
planet’s rings,) notice that the secondary light effect uses the 
RGB values of the layer to modulate the color of the effect as 
it moves behind the rings.

The elements on this page were used in the creation of the 
Saturn animation.

TuToRiaL 6: SaTuRn

elements
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Saucer Reflections, saucer..mov

Saucer Grays, gray.movie

Saucer beauty, beauty.mov

background, ground.mov

Shadow on Ground, shadow.mov

In this project I used Light Factory to generate a hot high-
light reflection off of the surface of this shiny UFO. The 
camera motion of the background element was generated 
in ElectricImage, as was the cast shadow on the ground, and 
the three individual passes of the UFO. 

By bringing these elements into After Effects as separate 
layers, I had greater flexibility over the final look of the shot 
without having to re-render in ElectricImage. The light ef-
fects are applied and animated within After Effects using 
keyframes for the light source position.

The Saucer animation was built from the elements on this 
page.

TuToRiaL 7: SauCeR

elements
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Sun Tracker, suntrack.mov

Windows Glow, window.mov

Glass, windows.w.alpha.mov

Cathedral, church.mov

I created this shot to demonstrate the auto-obscuration fea-
ture of Light Factory. As with the previous tutorials, I gener-
ated several rendered passes in ElectricImage. One of these 
passes—suntrack.mov—represents the position of the light 
source, and is used to auto-track the position of the light 
effect. The auto-obscuration is set to RGB, so that as the sun 
passes behind the stained glass window, the light effect will 
automatically be tinted to the color of the glass it is passing 
behind. 

You’ll also notice that I created a separate composition in After 
Effects so that I could add a separate glow pass to the window.

The Stained Glass animation was created from the elements 
on this page.

TuToRiaL 8: STained GLaSS

elements
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background Scene, dv.mov

hero Tree, tree.mov

More Trees, more.trees.mov

Sun Tracker, suntrack.movie

TuToRiaL 9: TRee

This project also uses auto-track and auto-obscuration. The 
twist here, however, is that the trees are not real, but were in 
fact generated within Electric Image (with an accompanying 
alpha channel for obscuration). As the sun effect moves 
behind the tree, note how effectively the obscuration is gen-
erated by Light Factory. 

Subtle details like this help to sell a shot as being real, even 
though when examined without the flare the trees and back-
ground look considerably less convincing.

The elements on this page were used in the creation of Tree.

elements
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